
07-Dec-09         300-DOC-BT-000-040 

 

 

 

 

 

 

 

FRONTLINE TEST SYSTE M™ 

 

SETUP AND QUICK START GUIDE 

FTS4BT™ 

 



 

07-Dec-09    300-DOC-BT-000-040 
i 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright © 2000-20010 Frontline Test Equipment, Inc. All rights reserved. You may not 
reproduce, transmit, or store on magnetic media any part of this publication in any way without 
prior written authorization of Frontline Test Equipment, Inc. 

FTS, Frontline, Frontline Test System, and ComProbe are registered trademarks of Frontline Test 
Equipment, Inc. FTS4BT is a trademark of Frontline Test Equipment, Inc. 

The Bluetooth SIG, Inc. owns the Bluetooth word mark and logos, and any use of such marks by 
Frontline is under license. 

All other trademarks and registered trademarks are property of their respective owners. 

 

 

 

 

 

 

 

 

 

 

 

 



 

07-Dec-09     ii    300-DOC-BT-000-040 
    

Packing List for FTS4BT (Full Version)  

 Bluetooth®  ComProbe® USB Adapter 

 USB 3-foot Extension Cable (Can be used with Bluetooth ComProbe  ) 

 Cable Set (for serial HCI sniffing), containing one Routing Cable, one Monitor Head (beige), one 
Source Head (black), three male 9-pin to female 25-pin adapters and one female 9-pin to male 
25-pin adapter 

 CD Case containing FTS4BT application software CD-ROM and this Setup and Quick Start Guide 

High Speed UART Option 

 The EB ComProbe with cable set 
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Packing List for FTS4BT (All Trial Versions)  

 Bluetooth ComProbe USB Adapter 

 USB 3-foot Extension Cable (Can be used with Bluetooth ComProbe) 

Some Trial Versions also include: 

 Cable Set, containing one Routing Cable, one Monitor Head (beige), one Source Head (black), 
three male  9-pin to female 25-pin adapters and one female 9-pin to male 25-pin adapter 

 CD Case containing FTS4BT application software CD-ROM and this Setup and Quick Start 
Guide 
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Minimum System Requirements  

 PC with Windows XP (Service Pack 2 or higher), Windows Vista (32 bit) or Windows 7 (32 
bit). 

 Pentium 1GHz processor  

 RAM Requirements: 1GB minimum, 2GB recommended  

 50 MB free Hard Disk Space (capture file size is only limited by disk size) 

For Air Sniffing: 

 1 USB Port, preferably a USB 2.0 port 

For Serial HCI Sniffing: 

 Minimum of one COM port, two required for bi-directional monitoring when using cable set 

 FTS4BT supports COM1 through COM64 

 Maximum data rate supported is dependent on PC processor speed 

For High Speed UART Option: 

 Windows XP Service Pack 2 or higher 

 One USB 2.0 High Speed enabled port. The EB ComProbe will not run on USB 1.1 Full Speed 
ports. 
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Introduction 

FTS4BT™ is a PC-based, Bluetooth protocol analyzer capable of sniffing Bluetooth data in five ways: 

 Through the air 

 From the Serial HCI interface between a Bluetooth Host CPU and a Bluetooth Host Controller 

 From the USB HCI interface between a Bluetooth Host CPU and a Bluetooth Host Controller 

 Optional High Speed UART 

 By "virtual" sniffing via the product's Live Import feature, which permits any application to feed data 
into FTS4BT. 

In this document, Serial HCI Sniffing Mode refers to sniffing over the HCI UART (also known as H4), 
HCI Three-Wire UART (also known as H5) and BCSP Transports. 

This Setup and Quick Start Guide was designed to get you up and running quickly with FTS4BT. It 
provides a high-level overview of product installation, initialization, and operation. The FTS4BT 
interface is easy to use without training, but you will want to read the FTS4BT Tutorial (found in 
the FTS4BT folder on the desktop) and the online Help manual to learn how to take maximum 
advantage of all the features. 

We have tried to make the online Help complete and easy to use. You can reach the online Help by 
choosing Help Topics from the Help menu, or by pressing the F1 key from any window. 

To access the PDF version of this Quick Start Guide from your Windows operating system, click 
Start |Programs |FTS4BT [version #] |Bluetooth Quick Start Guide. 
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FTS4BT Installation Instructions 

Software Installation 

Please refer to the installation and activation instructions in Installing, Activating, and Managing 
Frontline Test System Products in the installation folder. 

Hardware Installation 

As mentioned in the introduction, FTS4BT operates in five modes. Most of the configurations for 
three of these modes require hardware setup, and some instances require I/O settings as well. This 
section describes the setup procedures for each mode of operation. Skip to the sub-section for the 
mode you wish to use.  

Air Sniffing Mode 

Bluetooth ComProbe Installation on XP 

Step 1.   

Plug the Bluetooth ComProbe into a USB port. The Found New Hardware Wizard dialogue box 
appears which may ask you if you want to connect to Windows Update to search for software. 
Choose No, not this time and click Next. This process may vary slightly depending on your operating 
system. 

 

Figure 1 Hardware Update Wizard 
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Step 2.   

Choose Install from a list or specific location and click Next. 

 

Figure 2 Hardware Update Wizard 

Note that if you have already installed a Bluetooth ComProbe on your system you might not get the 
Found New Hardware Wizard. You may get this dialog in the future if you plug the Bluetooth 
ComProbe into a USB port that is different from one you have used previously. 

Step 3.  

Select the “Search for the best driver in these locations” radio button, and check only “Include this 
location in the search” checkbox. Browse to the directory where you installed FTS4BT. The default 
is C:\Program Files\Frontline Test System II\FTS4BT [version#]\Drivers\Bluetooth ComProbe. 
Select the appropriate directory and click OK. This directory contains the Bluetooth ComProbe and 
the Windows driver information file (bluetoothComProbe.inf) needed to install the driver. 

 

Figure 3 Select File Location Dialog 
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Step 4.   

Click the Next button to finish the Bluetooth ComProbe installation. If you get a dialog box like the 
one below, don’t worry—Click Continue Anyway. 

 

Figure 4 Hardware Installation 

Step 5.   

Your computer will now install the Bluetooth ComProbe driver from the directory you selected; you 
will get a dialog box saying that the installation is finished. Click the Finish button to close the 
wizard. 

The installation of the FTS4BT software and the Bluetooth ComProbe hardware is now complete.   

You are now ready to begin capturing data. Skip to the section titled Using FTS4BT. 

 

Bluetooth ComProbe Installation on Win7 

The procedure for installing the ComProbe driver is different for Win7.  Follow the steps below. 

 

Step 1. Plug the Bluetooth ComProbe into a USB port. The Found New Hardware Wizard dialogue 
box appears, then disappears. 

 

Figure 5 - Installing Driver - Win7 

Then a message similar to this one appears/disappears indicating that the generic Bluetooth 
adapter has been installed. 

 

Figure 6 - Driver Installed - Win7 
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Note: You may also see a message indicating that the driver was not installed correctly.  In either 
case, you will go to the Step 2. 

Step 2.  

Go to the Control Panel and open the Device Manager. 

 

Figure 7- Device Manager - Win7 

Right click on Generic Bluetooth Adapter and select Update Driver Software. 

 

Figure 8 - Update Driver Software - Win7 
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Step 3.  

The next step is to choose the driver location.  Select Browse my computer for driver software. 

 

Figure 9 - Browse my Computer - Win7 

 

Select Let me pick from a list of device drivers on my computer. 

 

Figure 10 - List of Device Drivers - Win7 
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Step 4.  

Select Generic Bluetooth Adapter under Model, then Have Disk. 

 

Figure 11 - Generic Bluetooth Adapter - Win7 

Step 5.  

On the Install From Disk dialog select Browse.  

 

Figure 12 - Browse for Driver - Win7 

Now you have to drill down to find the folder that contains the driver.  The driver is located at: 
Windows7\Program Files\Frontline Test System II\Frontline [Application Name and 
#]\Drivers\Bluetooth ComProbe. 

 

Figure 13 - Select Driver Location - Win7 
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Double-click on the Bluetooth ComProbe folder. 

 

Figure 14 - Bluetooth ComProbe - Win7 

Select  the Bluetooth_ComProbe file and click Open. 

 

Step 6.  

On the Install From Disk dialog select OK. 

 

Figure 15 - Install from Disk - Win7 

Step 7.  

Select Frontline Bluetooth ComProbe under Model, then select Next. 

 

Figure 16 - Select ComProbe - Win7 
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Once the driver starts to load:  

 

Figure 17 - Software Loading - Win7 

you may get a Windows Security warning. You can ignore this warning by selecting Install this 
driver software anyway. 

 

Figure 18 - Security Warning - Win7 

Your computer will now install the Bluetooth ComProbe driver from the directory you selected; you 
will get a dialog box saying that the installation is finished.  

 

Figure 19 - Installation Complete - WIn7 

Step 8. Click the Close button to close the wizard. 
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When you close this dialog you will see that the correct driver is displayed in the Device Manager. 

 

Figure 20- Device Manager - Win7 

Serial HCI Sniffing Mode 

Cable Installation 

If you do not have the serial HCI sniffing cables that are provided with the full version of FTS4BT or 
if those cables are not practical for you to use (for example, if you are developing an embedded 
device) then see the section called Connecting Directly to Serial Ports. 

The exact details of how to tap the circuit vary widely depending on the application or hardware 
being developed. There are two basic methods for feeding signals from the circuit into the serial 
ports of the PC running FTS4BT. One method uses the cable set provided with FTS4BT and the 
other sends signals directly to the serial ports. In either case, if the signals coming from the system 
under test are not RS-232, it might be necessary to use a converter. 

If your Bluetooth Application is running on the PC that is running FTS4BT, an alternative is to run 
FTS4BT in Spy mode. Spy monitors data directly from the serial port on the PC running the 
Bluetooth application. In this situation, no cables or converters are needed and no extra wiring 
needs to be done. 

It is strongly recommended that you set the Host to be DTE and the Host Controller to be DCE; 
otherwise, the Commands and Events may be reversed.   

 

 

 

 

 

 

 



 

07-Dec-09      11   300-DOC-BT-000-040 

Connecting Cables to Monitor a Circuit 

The instructions and diagram below explain how to connect the cables to the PC running FTS4BT 
and to the circuit being monitored. This information assumes that you have two serial ports 
available on the PC running FTS4BT. Two serial ports are required in order to see both sides of the 
circuit. If you have only one serial port, you will only be able to monitor one side of the circuit. See 
the Online Help under Cable Configuration for instructions on setting up the cables with one serial 
port. 

 Connect the two 9-pin connectors on the Routing Cable to the two serial ports on the PC 
running FTS4BT. 

 Connect the Monitor Head (beige) to the 25-pin connector on the Routing Cable. The cable 
set includes a beige Monitor Head and a black Source Head that, aside from their color, look 
very similar; be sure you have the correct cable Head. 

 Connect the T-connector on the Monitor Head to the circuit. The Monitor Head is a straight-
through connector. Use the adapters provided to convert between the 25-pin Monitor Head 
and any 9-pin connections on your circuit. 

 

Figure 21 Wiring Diagram 

 Click on Hardware Settings and select Use FTS Cables. You will also need to select which COM Ports 
you will be using.  

 Skip to the section titled I/O Settings. 
 

Connecting Directly to Serial Ports 

In order for FTS4BT to capture data correctly, when not using the cable set, TxD, RxD and Signal 
Ground need to feed to the proper pins on the serial ports of the PC running FTS4BT. Note that 
FTS4BT will not be able to monitor control signals without the cable set. 

 Connect the Serial Data Out of the Host to the Serial Data In of the Host Controller. Connect this also 
to the RxD of the COM Port that will be selected in the Upper List Box of the Hardware Settings. 

 Connect the Serial Data In of the Host to the Serial Data Out of the Host Controller. Connect this also 
to the RxD of the COM Port that will be selected in the Lower List Box of the Hardware Settings. 

 Connect the Signal Ground of the Host to the Signal Ground of the Host Controller and to both COM 
Ports. 
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 Click on Hardware Settings and select Use FTS Cables.   

 Also in Hardware Settings, select the COM Ports you will be using as directed in steps 1 and 2.   

 Disable Notify if Auto Detect Fails. This will prevent FTS4BT from looking for FTS Cables. 

 

Figure 22 Cable Connection Diagram 
 

You are now ready to begin capturing data. Skip to the section titled Using FTS4BT. 

 

Connecting to a Port Using Spy 

Important! In order to monitor an internal port, FTS4BT must be started before the application 
using the port. This ensures that both FTS4BT and the application use the FTS4BT serial driver. 

 The computer running Spy should be the Host talking to the external Host Controller. 

 Click on Hardware Settings and select Spy. You will also need to select which COM Port you 
will be using. 

No special hardware setup needs to be done to monitor an internal port. 

You are now ready to begin capturing data. Skip to the section titled Using FTS4BT. 

 

I/O Settings 

Start FTS4BT in Serial HCI mode by running Serial HCI Sniffer (H4), Serial HCI Sniffer (H5) or Serial 
HCI Sniffer (BCSP). 

Before you can begin capturing data, you need to tell FTS4BT whether you intend to monitor or 
transmit data, and at what data rate. You give FTS4BT this information in the  I/O Settings window.  

 Click on the I/O Settings icon  on the Control window toolbar, or choose I/O Settings 
from the Window menu.  

 In the Operating Mode box, choose Monitor Both. If you have only one serial port, choose 
either Monitor DTE or Monitor DCE, depending on which side you want to see. 
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 Set the baud, parity, word length and stop bits to the correct settings for both sides of the 
circuit. For Spy, it is not necessary to set these values, as the Bluetooth application will do 
this when it is started. In Spy Mode, these boxes automatically reflect the values being used 
by the application. 

 Click the Close button. 

You are now ready to begin capturing data. Skip to the section titled Using FTS4BT. 

USB HCI Sniffing Mode 

The USB HCI Sniffing Mode is capable of capturing and decoding USB packets. There are three ways 
to capture USB data. Two of these require the USB ComProbe. 

 USB HCI Sniffer (H2) - Internal Software Tap: Captures USB data internally by monitoring the data 
passing between the USB driver and the device driver inside the PC.  No hardware installation or 
additional software setup is necessary for this mode, as all files install during the FTS4BT installation. 

 USB HCI Sniffer (H2) - USB ComProbe: Captures Bluetooth  HCI data carried over USB using the USB 
ComProbe, and filters out Non-HCI packets. 

 USB HCI Sniffer (H2) + Raw USB Packets - USB ComProbe: Captures raw USB packets using the USB 
ComProbe, and optionally filters out NAKs and SOFs with user configured Capture filters. 

If you wish to capture USB data using the USB HCI Sniffer (H2) - Internal Software Tap option, then 
continue with the next section titled Internal Software Tap. 

However, if you wish to capture USB data using the USB HCI Sniffer (H2) - USB ComProbe option or 
the USB HCI Sniffer (H2) + raw USB Packets - USB ComProbe, then skip to the section titled Installing 
the USB ComProbe. 

Internal Software Tap 

Internal Software Tap requires no additional hardware.  It sits between the USB driver and the 
device driver inside the PC. 

Start USB HCI sniffing by running USB HCI Sniffer (H2) - Internal Software Tap from the FTS4BT 
folder on your desktop. The FTS4BT USB HCI Datasource dialog appears. 

 

Figure 23 USB HCI Datasource 
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The USB HCI Datasource dialog allows the user to select which Bluetooth device to sniff and to 
initiate and terminate the sniffing process. 

The dialog has a list containing the Bluetooth Devices connected to your system.  If the Show 
Connected Only checkbox is unchecked then all USB devices that have ever been connected to your 
system will be listed. 

 If you have connected or disconnected a device while this dialog is open, click on Refresh 
List to update the list. 

 Select the device you wish to sniff then click on the Start Sniffing button (this must always 
be done in order to capture data in this mode). 

You are now ready to begin capturing data. Skip to the section titled Using FTS4BT. 
 

Installing the USB ComProbe 

The USB ComProbeis a high speed, full speed and low speed USB 2.0 protocol analyzer that sends 
data to the analyzer PC using a high-speed USB 2.0 connection. 

The front of the ComProbehas two USB connections; one for the Device Under Test (DUT) and one 
for the PC where the device is normally connected. 

There are three LEDs on the front panel (1) the Power LED, (2) the Activity LED, and (3)the Trigger 
LED. 

 The Power LED will be either red or green, and either steady or flashing. 

 Green means the USB port on the Analyzer PC is 2.0. 

 Red means the port is not a 2.0 port.  

 Flashing means the analyzer is not yet initialized or there is a driver problem 

 Steady means all is well. 

 The Activity LED flashes when the ComProbe senses activity on the circuit. 

 The Trigger LED is not used in this version. 

The back panel has one USB connection labeled "Analysis Computer" for connecting the USB 
ComProbe to the computer running FTS. 

The ComProbe receives power from the USB port of the analysis computer eliminating the need for 
an external power source. 

USB COMPROBE DRIVER INSTALLATION 

Step 1.  

Connect the white USB cable to the back of the ComProbe in the USB port labeled “Analysis 
Computer”.  Connect the other end to a USB port on the computer with FTS installed. 

The Welcome to the Found New Hardware Wizard appears. 
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Figure 24 - Welcome to the Found New Hardware Wizard 

If you have installed FTS4BT, the hardware driver should be installed, so you don’t have to search 
for it. 

Select No, not this time, then Next. 

The Found New Hardware Wizard dialogue box will appear.  Choose Install from a list or specific 
location and click Next.    

 

Figure 25 - Found New Hardware 

Step 2.  

Select the “Search for the best driver in these locations” radio button, and check only “Include this 
location in the search” checkbox. Browse to the directory where you installed FTS4BT. The default 
is C:\Program Files\Frontline Test System II\FTS4BT [version#]\Drivers\USB ComProbe. Select 
the appropriate directory and click OK. 

 

Figure 26- Search and Installation Options 



 

07-Dec-09 16  300-DOC-BT-000-040  

Step 3.  

Click the Next button to finish the installation. If you get a dialog box like the one below, don’t 
worry—Click Continue Anyway. 

 

Figure 27- Windows Logo Testing 

Step 4.  

Your computer will now install the USB ComProbedriver from the directory you selected; you’ll get 
a dialog box saying that the installation is finished.  Click the Finish button to close the wizard. 

The installation of the USB ComProbe driver is now complete.   

 

Connecting the USB ComProbe to the Device Under Test (DUT) 

The USB ComProbe is a high speed, full speed and low speed USB 2.0 protocol analyzer that sends 
data using a high-speed USB 2.0 connection. The recommended configuration requires two 
computers, one for communicating with the device under test and the other for displaying the 
results of the analysis.  

Although the USB ComProbe can download analyzed data 
on a full speed USB 1.1 connection, we strongly 
recommend that you connect it using a high speed USB 2.0 
port to obtain optimal performance. If you experience any 
trouble with your analyzer, please ensure it is connected 
on a high speed USB 2.0 enabled host controller before 
contacting our technical support. 

CONNECTING ONLY ONE DEVICE UNDER TEST 

The most straightforward configuration involves analyzing only one device.  Figure 28 shows the 
proper connection setup for a single Device Under Test.  
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Figure 28 Connecting only one Device Under Test 

To prevent connection problems, please adhere to the following instructions: 

 Make sure that NO USB DEVICE is plugged into the same root hub as the Device Under 
Test (DUT).   An extraneouos USB device can result in FTS capturing data from the 
device, not the DUT. 

 The Analysis computer cable must be no longer than 5 meters. 

 The total length of the Test computer and Device Under Test cables must not exceed 3 
meters. A greater length could result in an abnormally high error rate on the bus being 
analyzed. 

CONNECTING MORE THAN ONE DEVICE UNDER TEST 

USB analyzers only analyze traffic coming from devices connected below the analyzer. Traffic 
coming from devices connected above the analyzer is not analyzed. The analyzer will only register 
data packets coming from the host. Figure 29 shows an incorrect connection.  The USB mouse 
connected above the analyzer is not analyzed.   

 

Analysis computer 
Test Computer 

Device Under Test 

Device Under Test 

Analysis computer Test Computer 
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Figure 29 Wrong connection with more than one DUT 

When analyzing multiple devices, the analysis requires the use of a USB hub. Using a USB hub 
connected to the ComProbe ensures analysis of all devices.  Be aware that the analyzer records all 
hub and device traffic, and could result in a large amount of data.  The software's functions easily 
filter out extra traffic eliminating any inconvenience a large data set may cause. Figure 30 illustrates 
proper connection of several devices under test.  

 

Figure 30 Correct connection with more than one DUT using a Hub  

 

Hardware Settings 

The Hardware Settings window will appear automatically the first time FTS is run.  Choose 
Hardware Settings from the Options menu on the Control window if you need it later. 

USB COMPROBE/CAPTURE FILTERS 

Use the Hardware Settings window to select which USB ComProbe to monitor (if you have more 
than one) and to choose which capture filters to apply.   

There are two capture filters, one for SOF packets and one for NAK packets.  Click the Capture 
Filters button on the Hardware Settings window to change the capture filter selections.  By default, 
both filters are selected, which means all SOF and NAK packets will be filtered out. 

Troubleshooting 

Most performance problems such as input buffer overflow are the result of improper connections. 

To achieve optimal performance from the USB analyzer, we recommend the following 
configuration: 

 use two high-speed computers, one for the analyzer and one for the device under test 

 use USB 2.0 connections 

 use cables that do not exceed the recommended maximum lengths (the cable connected to 
the analysis computer should not exceed 15 feet, and the total length of the cables 
connected to the test computer and the device under test should not exceed 9 feet). 

Analysis computer 

Test Computer 

Device Under Test 



 

07-Dec-09      19   300-DOC-BT-000-040 

Although it is possible to use one computer as both the analysis and the test computer, this requires 
that the computer in use is high-speed and has two or more host controllers available. If you 
attempt to analyze data using one computer with only one host controller, then the system displays 
an error message informing you of the problem. 

If the operating system encountered an error when trying to install a device, simply disconnect the 
device, then reconnect it and try again. 

High Speed UART (HSU) Option 

Note: You must be running Windows XP and have USB 2.0 port available to operate the EB 
ComProbe. 

After installing your FTS4BT software, simply plug the EB ComProbe into an available USB 2.0 port. 
Your operating system automatically installs the necessary drivers. 

 

Hardware Settings for HSU 

The Hardware Settings window appears automatically the first time you run FTS. Use the Hardware 
Settings window to select which EB ComProbe to monitor (if you have more than one). Choose 
Hardware Settings from the Options menu on the Control window if you need it later. 

 

I/O Settings for HSU 

Click the I/O Settings icon  on the Control window. The analyzer requires information on Bit 
Rate, Parity, Length, and number of Stop bits in order to operate properly.  If you are capturing 
framed data, the analyzer needs to know what protocols are present on your circuit to decode them 
correctly. 

There are two rows of settings, one for the CH 0 (data connection), and one for the CH 1 (data 
connection).  To change the bit rate, parity, word length or number of stop bits, click on the down 
arrow next to the setting box and choose an option from the list.  For bit rate, you can either choose 
a listed rate or enter a rate. After entering the settings for CH 0, click the Copy CH 0 button to apply 
the same settings to the CH 1 row. 

Connect the EB ComProbe to a Source 

The EB ComProbe is designed for use with TTL voltage levels, 0 to 5 volts max (exceeding the 5.0 
volts max damages the ComProbe®). The ComProbeinterprets 0 to 1.9 volts as a logical zero, and 
2.0 to 5.0 as a logical one. To ensure accurate data collection and proper operation, connect the 
ComProbeto the TTL side of any transceivers, line drivers, or line receivers. 

Use the table below to determine the connection configuration you need for monitoring signals on 
the source device. Disconnecting and reconnecting the wires in a different configuration negates the 
validity of the following table. To avoid confusion, we recommend that you maintain the color code 
as expressed in this table. 
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Note: Disconnecting the EB ComProbefrom the source while capturing data with FTS4BT may 
temporarily affect your computer’s performance. To ensure proper operation of your system, 
always terminate FTS4BT live capture prior to removing the ComProbefrom the circuit under test. 

Wire 
Label 

Label/Wire 
Color 

Signal Meaning 

0 Black CH 0 Data Connection 

1 Brown CH 1 Data Connection 

2 Red RTS Request to Send 

3 Orange CTS Clear to Send 

4 Yellow DSR Data Set Ready 

5 Green DTR Data Terminal 
Ready 

6 Blue CD Carrier Detect 

7 Violet RI Ring Indicator 

TRG White Not Used N/A 

CLK Gray Not Used N/A 

GND Black Ground Ground 

Table 1 Pin outs for the EB ComProbe 

Virtual Sniffing Mode 

There is no hardware installation necessary for virtual sniffing. During the software installation, a 
sample Virtual Sniffing Application is installed. To use virtual sniffing in your environment, modify 
the sample application to import data from your software. For more information, please contact 
Technical Support. Contact information is at the end of this document. 
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Opening FTS4BT 

  

On product installation, the installer creates a folder on the windows desktop labeled Frontline 
FTS4BT. 

1. Double-click the Frontline FTS4BT desktop folder  

 This opens a standard Windows file folder window. 

  
   

2. Double-click on Frontline FTS4BT and the system displays the Select Data Capture Method 
dialog. 

 Note: You can also access this dialog by selecting Start > All Programs > Frontline FTS4BT 
(Version #) > Frontline FTS4BT. 

 This dialog lists all the methods FTS4BT supports in a tree control.  
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Three buttons appear at the bottom of the dialog; Run, Cancel, and Help. When the dialog first 
opens, Cancel and Help are active, and the Run button is inactive (grayed out). 

 Starts FTS using the selected protocol stack. 

Closes the dialog and exits the user back to the desktop. 

Takes the user to this help file as does pressing the F1 key. 
 

3. Expand the folder and select the data capture method that matches your configuration.  

 Note: If you don't need to identify a capture method, then click the Run button to start the analyzer. 

 Creating a Shortcut 

 A checkbox labeled Create Shortcut When Run is located near the bottom of the dialog. This box 
is un-checked by default. Select this checkbox, and the system creates a shortcut for the selected 
method, and places it in the FTS4BT desktop folder and in the start menu when you click the Run 
button. This function allows you the option to create a shortcut icon that can be placed on the 
desktop. In the future, simply double-click the shortcut to start the analyzer in the associated 
protocol. 
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Using FTS4BT 

The Control Window appears as the small rectangular window at the top of your monitor screen. 
FTS4BT is organized around this window. The Control window allows you to control data capture 
and access the other windows used to view data. 

How to Capture Data 

Initiating Data Capture in All Sniffing Modes 

FTS4BT will capture data to a single file or series of files. Data capture can be initiated from the 
Control window, the Event Display or the Frame Display. You do not need any window other than 
the Control window open to capture data.   

 To capture to a file, click the Start Capture  icon  . 

 To stop capture to a file, click the Stop Capture icon .    Stopping capture means no new 
data will be added to the capture file until capture is resumed by clicking the Start Capture 
icon.  The previously captured data remains in the file. 

 To clear capture, click the Clear  icon .   

If you select Clear after selecting Stop, a dialog appears asking whether you want to save 

the data.   

 You can click Save File  and enter a file name when prompted .   

 If you choose Do Not Save, all data will be cleared. 

 If you choose Cancel, the dialog closes with no changes. 

If you select the Clear icon while a capture is occurring: 

 The capture stops. 

 A dialog appears asking if you want to save the capture 

 You can select Yes and save the capture or select No and close the dialog.  In 

either case, the existing capture file is cleared and a new capture file is started. 
 

 If you choose Cancel, the dialog closes with no changes. 

Note: If you receive a message to run the Maintenance Utility, refer to Appendix A, for more information. 

Capturing Data in Air Sniffing Mode 

This Quick Start Guide only describes Air Sniffer (Basic). You can find more information about the 
other air sniffing modes in the online Help and by calling Technical Support (see the end of this 
document for contact information). 
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There are two steps to capturing data in the FTS4BT Air Sniffing mode. The first is initiating data 
capture (see previous section), and the second is synchronizing the Bluetooth ComProbe to the 
Bluetooth piconet. Data capture is initiated via the Control window, as explained in the previous 
section. We recommend beginning data capture before synchronizing the ComProbe so that when 
data begins arriving, FTS4BT is ready to capture it. 

 Note: If you see a message that indicates No Bluetooth ComProbewas found connected to a USB port., the reason 

is that FTS4BT Versions 7.3.5 and later require that a Bluetooth ComProbebe connected to the PC regardless of 

how data is captured. Before continuing you must connect a Bluetooth ComProbe.  

 

Synchronizing to the Piconet 

Step 1. Connect the ComProbe 

Make sure the Bluetooth ComProbe is connected to a USB port. 

Step 2. Start Air Sniffer 

Open the FTS4BT folder on your desktop and double-click Air Sniffer (Basic). This will cause FTS4BT to 
start and the Bluetooth ComProbe icon appears in red with a line through it in your system tray. In 
addition, the Datasource dialog box appears. 

Step 3. Select a ComProbe Device 

If you have multiple Bluetooth ComProbes® installed, then you will need to click the Hardware 
Settings button on the Datasource dialog to pick which one you want to use.   

Step 4. Synchronization 

You must next tell FTS4BT which synchronization mode to use. Click the I/O Settings button on the 
Datasource dialog. 

At the top of the I/O Settings window, choose a synchronization mode. The preferred mode is Slave 
Inquiry. In this mode, FTS4BT asks the slave device for its clock and then waits for the master to 
page the slave.   

In Bluetooth®, the device that initiates the connection is always the master at connection time. You 
only need to know the master and slave at connection time when setting up the I/O settings. 
Afterwards a role switch may occur, but FTS4BT will automatically follow the role switch. 

The rest of these instructions assume you have selected Slave Inquiry mode. For more information 
on the other synchronization modes, see the online Help.  

Enter in the Slave Device box the Bluetooth Device Address of the slave device to which FTS4BT 
should synchronize. If you know the device address, you can simply enter it using the 12 hex digits 
box or UAP, LAP and NAP. Otherwise, click the Discover Bluetooth Devices button and then select the 
correct device from the drop-down list. You may wish to specify a Master Device as well if you want 
to be certain of monitoring a specific piconet. 

If you are sniffing an encrypted session, you must set the encryption settings correctly. For the 
details on these settings, consult the Encryption topic in the online Help. 



 

07-Dec-09      25   300-DOC-BT-000-040 

Finally, there are some optional settings for capture filtering and for using inquiry access codes to 
limit the list of devices returned when Discover Bluetooth Devices is clicked. See the information on 
the I/O Settings window in the online Help if you wish to change these settings. 

Click OK when finished. 

Piconet Synchronization State 

As data is being captured, the Status box at the top of the Datasource dialog will update to show the 
piconet synchronization status of the Bluetooth ComProbe®. 

You will also note that the color of the Bluetooth ComProbeicon in the system tray and in the Status 
box will vary in color depending on the state of the Bluetooth ComProbe®:   

 Blue indicates that the Bluetooth ComProbeis running and in sync with the piconet.   

 Green indicates that the Bluetooth ComProbeis running and in sync with the slave and 
waiting to synchronize with the piconet.   

 Yellow indicates that the Bluetooth ComProbewill attempt to resynchronize within 5 
seconds,  

 Red indicates that the Bluetooth ComProbe is attempting to synchronize, 

 Red with a "Not" symbol means the Bluetooth ComProbeis stopped. 

Typically, you can focus your attention on the FTS4BT data displays and not worry about the 
Bluetooth ComProbe®. However, if you are not seeing data when you think you should, then check 
the Datasource dialog. 

Looking At Frames 

Protocol Navigator 

Click the Protocol Navigator icon  on the Control window toolbar to open the Protocol 
Navigator. The Protocol Navigator window presents decodes of multiple protocol layers within 
multiple data frames. It simplifies the process of understanding the complex relationships between 
multiple data frames and the protocol layers that comprise the frames. The three windowpanes on 
the left of the Protocol Navigator enable you to select or suppress protocols of interest. 

 

Filtering/Hiding in Protocol Navigator 

You can filter on one or more protocol layers by using the Filtered In pane at the top left of the 
Protocol Navigator display. In the pane is a list of all the protocols seen so far on the circuit.  Three 
additional filters available are: 

 All Frames With Bookmarks - filters in all frames with a bookmark associated with them. 

 All Frames With Errors - filters in all frames with errors. 

 All Special Information Nodes - filters in all special information nodes. 
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Check the boxes next to the names of the protocols you want to filter in. The filter is inclusive, 
which means that filtering on a protocol displays only frames that contain that protocol.  Frames 
that do not contain the protocol will not appear.  You can filter on one or more protocols. 

The system provides a means to create and save your own filters. Please consult the online Help 
under Filtering for instructions. 

Also on the left side of the window is Layers Hidden From View.  All the layers seen in the 
protocol will be displayed with a check box next to them.  This allows you to zoom in on a particular 
protocol by hiding every protocol but the one of interest. This is especially effective when all the 
layers are expanded. 

 If you want to see the layer, leave the check box unchecked.   

 If you want to hide a layer, select the check box next to it. 
 

When one or more layers are hidden, a note will appear at the top of the Protocol Navigator saying, 
"Some layers are hidden. Right-click to see." This message warns you that some layers are hidden. 

 You can also use the right click menu to hide/display frames and layers.  Simply right click on a 
frame or layer.  The right click menu displays options based on what you have selected.  For example, 

if you right click on the the USB Token Message, you will see in the right click menu that you can choose, Exclude 

"USB Token Message" Layer in All Frames.    If you right click on  a frame you probably will see: Show Frames, 

Show Layers, Show All, Include All Layers, Exclude All Layers. 

 

Frame Display 

Click the Frame Display icon on the Control window toolbar to open the Frame Display. This 
display allows you to have bit level visibility on your protocol.   

Panes 

The Frame Display is divided into panes, where each pane shows a different view of the data. The 
Summary pane stretches across the top of the display. Each line in the Summary Pane represents 
one frame except when running in one of the USB HCI Sniffing modes where each line represents 
one transaction. The Decode pane contains a detailed decode of the frame/transaction selected in 
the Summary pane, and is located on the left side of the Frame Display window. The three smaller 
panes on the bottom right of the Frame Display show the data in hex, binary and ASCII. The user 
can choose to have these panes show the data in other radixes or character sets. Select any field in 
the Decode pane and the corresponding bit(s) or byte(s) will be selected in the data panes. 

Frame Errors 

Frame numbers in red indicate an error in the frame. Select the frame, and look at the top of the 
Decode pane to determine the type of error. 
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Scrolling versus Static View 

Click the Lock/Resume icon  to have the Summary pane scroll to always show the latest frames 
captured.  Click the Lock/Resume icon again to stop the Summary pane from scrolling. 

Protocol Tabs 

The frame display has a series of Protocol Tabs that allow you to filter on a specific protocol quickly 
and easily.  For more advanced filtering option please consult the online Help. 

Common Features 

Display Synchronization 

The system synchronizes the display in the Frame Display with the Event Display and Protocol 
Navigator.  Select a frame in the Frame Display and the other windows automatically update to 
highlight the bytes in the selected frame.  Select a byte in the Event Display or Protocol Navigator, 
and the Frame Display updates to show the frame containing the byte.  

Duplicate Displays 

The Duplicate icon creates a second window of the same type, identical to the first.  The 
advantage of additional Displays is that you can look at two different groups of data at the same 
time.  For example, you can look at the start of an interaction in one Frame Display and the end of 
that same interaction in the other and compare the two. 

Filtering 

Filtering can be accomplished from both the Protocol Navigator and the Frame Display. Regardless 
of where the filter is applied, it affects the data in both. In the Protocol Navigator, the filter displays 
the data that meets the condition defined in the filter. In the Frame Display, the system creates a tab 
that displays the filter name. 

The quickest and easiest method for filtering data is to hover your cursor over the desired 
information in the summary display or the decode pane on the Frame Display and select from the 
right click popup menu. 

Bookmarks 

Bookmarks let you mark frames of interest so they can be easily found later.  Bookmarked frames 
appear with a magenta triangle icon next to them except in the Event Display where they appear as 
a dashed line around the start of frame marker.  You can navigate between bookmarks using the 
Find feature or by pressing F2 to go to the next bookmark.  To make a new bookmark, right-click on 
the frame and choose Add Bookmark from the menu. 
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Searching 

You can search for strings or patterns in your data or in the frame decode, for errors, control signal 

changes, bookmarks, special events, and time.  Click the Find  icon to open the Find window. 
Click the Help button for more information on the different types of searches.  

Statistics 

Serial HCI and USB HCI Sniffing Modes 

Click the Statistics icon  on the Control window toolbar to open the Statistics window. 

The Statistics window provides a statistical overview of all the data on the circuit. In Serial HCI 
Sniffing mode, FTS4BT is always monitoring the circuit and gathering statistics, even when it is not 
capturing the data. In the Air Sniffing Mode FTS4BT only gathers statistics when it is synchronized 
with the piconet. 

There are three tabs on the Statistics window: Session, Resettable and Capture File. The Session tab 
shows statistics from the time FTS4BT was started. The Resettable tab can be reset to show 
statistics from the time the Reset icon was last pressed. The Capture File tab shows statistics on the 
data in the capture file. If data capture has not been started or if the file has wrapped, most of the 
statistics on the Capture File tab will be "n/a". 

Some tables on the Statistics window can display data in graphic form. Click the Graph icon  on 
any header that has one for a chart of that table. 

Air Sniffing Mode 

When operating in one of the Air Sniffer modes, Packet Error Rate Stats provides a dynamic 

graphical representation of the Packet Error Rate for each channel. Click on the  button to 
display the Packet Error Rate Stats window. 

The Packet Error Rate window displays a graph for each channel numbered 0 through 78 and a pie 
chart summarizing the total of all channels. 

Each individual graph/table displays the following parameters: 

 Total number of packets (determined by reading the scale to the left of the graph) 

 The number of packets with no errors, color-coded green 

 The number of packets that have header errors, color-code red 

 The number of payload errors, color coded dark red 

 The number of retransmits, color-code yellow 
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Additional Displays 

There are additional displays that may be of value to those doing serial HCI sniffing.  

The Event Display can be used to see the data transferred between a Host and a Host Controller 
before the data is decoded. Communications errors on the serial data circuit, such as overrun, 
framing, and parity can only be seen on the Event Display. The Event Display shows where each 
frame begins and ends. This can be helpful when diagnosing transport synchronization problems.  

When a transport such as HCI UART (H4) uses hardware flow control, the Breakout Box  and 

Signal Display  windows can be used to help diagnose problems with missed messages and 
data overruns. 
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Coexistence View Introduction 

The Coexistence View displays both the Bluetooth® and the Wi-Fi channels frequencies in one 

view.  You access the Coexistence View by selecting the  icon  from the ControlWindow, 
Frame Display, and Protocol Navigator toolbars or from the View menus. 

Main User Interface  

 

Figure 31 - Coexistence View 

 

 

This chart displays the: 

Bluetooth: Average Throughput/ 1 Second Throughput 
This chart displays: 

 Average Throughput in bits/seconds for all Bluetooth packets, Bluetooth Master packets, 
and Bluetooth Slave packets. 

 One (1) Second Throughput in bits/seconds for all Bluetooth packets, Bluetooth Master 
packets, and Bluetooth Slave packets.  
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 Average Throughput  =  total packet/payload size divided by the duration of the 
entire session  

 1 second Throughput = packet/payload size during the most recent one second of 
the session 

  
Wi-Fi: Average Throughput/ 1 Second Throughput 
This chart displays the 

 Average Throughput in bits/second and One (1) Second Throughput in bits/seconds for Wi-
Fi. 

 Average Throughput  =  total packet/payload size  divided by the duration of the 
entire session 

 1 second Throughput = packet/payload size during the most recent one second of 
the session 

 

 

This chart displays the 
 Average Throughput in bits/second and One (1) Second Throughput in bits/seconds for Wi-

Fi. 
  

 Average Throughput  =  total packets divided by time 
  

 1 second Throughput = most recent one second during the session 

 

This legend identifies the color coding found in the timeline.  When you select a packet in the 
timeline, its attributes are highlighted in the legend.  A bold entry in the legend indicates that such a 
packet has been seen during the current session.   
  
A Bluetooth packet has a blue outline, and a Wi-Fi packet has an orange outline. 
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The Throughput Graph displays throughput over time. 
  

 Wi-Fi packet throughput is displayed as an orange line with corresponding orange numeric 
values on the left. 
  

 Bluetooth  packet throughput is displayed as a blue line with corresponding blue numeric 
values on the right. 
  

 When you click anywhere in the graph, the timeline moves to the corresponding position in 
time.  
  

 To keep the timeline and the throughput graph manageable, big jumps in packet 
timestamps are not represented linearly. Instead, they are shown as discontinuities.   A 
discontinuity is said to exist when the timestamp goes forward more than 2 seconds or 
backwards any amount. A discontinuity is indicated by a cross-hatched slot in the timeline 
and a corresponding vertical dashed line in the throughput graph. 
  

 You can show Packet Throughput, Payload Throughput, or both depending on which radio 
button to the right of the graph you select.  The Avg Throughput and 1 Sec Throughput 
indicators are also affected. 
  

 Payload Throughput is always less than Packet Throughput because a packet is never all 
payload. 
  

 The green area in the throughput graph is called the viewport.  Its position and width 
correspond to the beginning timestamp and duration of the timeline.     

 

The main part of the chart displays a variety of information. 
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 The timeline shows Bluetooth and Wi-Fi packets within a specific period of time.  
  

 The horizontal lines in the timeline are rows that correspond to Bluetooth and Wi-Fi 
frequencies. 
  

 The vertical blue lines are Bluetooth slot markers for reference. 
  

 The timeline displays Bluetooth and 2.4 GHz Wi-Fi packets together in the 2.4 GHz range 
when you select the 2.4 GHz Timeline radio button. 
  

 The timeline displays 5 GHz Wi-Fi packets in the 5 GHz range when you select the 5 GHz 
Timeline radio button. 
  

 The timeline displays Bluetooth/Wi-Fi packets in the 2.4 GHz range and Wi-Fi packets in the 
5 GHz range when you select the Both Timelines radio button. 
  

 The timeline duration is displayed underneath the timeline. 
  

 Placing the mouse pointer on a packet in the timeline displays information about that 
packet in an information box.  
  

 You can select multiple packets by dragging within the timeline or by holding the SHIFT key 
down while arrowing. 
  

 On the 2.4 GHz Timeline, there are 79 Bluetooth and 14 Wi-Fi channels.  Channel numbers 
are shown on the left side of the timeline.  Bluetooth channel numbers have a blue 
background, and Wi-Fi channel numbers have an orange background.  

  

 On the 5 GHz Timeline, there are 31 Wi-Fi channels.  Channel numbers are shown on the left 
side of the timeline with an orange background.  The channel spacing varies from 20 to 40 
MHz. 
  

 Each Bluetooth channel is 1 MHz wide with no channel overlap.   
  

 Each Wi-Fi channel in the 2.4 GHz range is 22 MHz wide and overlaps.  There is a 5 MHz 
shift between each of the first 13 channels.  There is a 12 MHz shift between channels 13 
and 14.The row labels for channels 1-13 are placed at the center frequency of each channel. 
 Channel 14 is in parentheses because that channel’s center frequency is above the top of 
the graph.Due to space limitations, each Wi-Fi channel in the 5 GHz range is drawn with a 
fixed height instead of being sized and spaced relative to its width and distance from other 
channels. 
  

 When both timelines are visible, selecting packets by dragging with the mouse applies to 
packets in both timelines, regardless of which timeline the mouse is in. 
  

 Using the mouse scroll wheel scrolls horizontally in the chart.  You can also use the arrow 
keys and the scroll bar at the bottom of the timeline to move within the timeline. 
  

file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Bluetooth_Channel_Frequencies.htm
file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Wi-Fi_Channel_Frequencies.htm
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 Using the mouse scroll wheel + CTRL zooms.   You can also zoom by using a right click 
(which displays specific magnification values), using the + and - Zoom tools, or by selecting 
a value from the Zoom menu. 
  

 Selecting the Information icons  displays information about the Bluetooth  and Wi-Fi 
channels. 
  

 A green border appears around Wi-Fi Tx and Bluetooth Master. 

Coexistence button bar 

The button bar contains the following: 

  

  

 

Lock 

   

Unlock 

 

First Packet 

 

Previous Packet 

 

Next Packet 

 

Last Packet 

 

Previous Error Packet 

 

Next Error Packet 

 

Zoom To All Packets 

 

Zoom In Tool 

 

Zoom Out Tool 

 

Reset 

  

file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Coexistence_View_Wif-Fi_Tx_Address.htm
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The Lock button only appears in live mode and is automatically depressed when the user scrolls. 

Coexistence View Wif-Fi Tx Address 

  

The Wi-Fi Tx Address displays a selected source address that you choose.  

  

 The specific address is highlighted with a green border. 

  

To select a specific address: 

1. Click the Select button. 
  

The Wi-Fi Tx Address dialog appears. 

 

2. Select an address from the drop-down list. 
  

3. Select OK. 
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The selected address appears with a green border around it. 

  

Bluetooth Channel Frequencies 

There are 79 Bluetooth channels in the 2.4 GHz timeline.   The Bluetooth channel numbers appear 
with a blue background along the left side of the timeline. 
  
  

 
   
 
 
Each Bluetooth channel is 1 MHz wide with no channel overlap, unlike Wi-Fi channels which do 
overlap. 
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Selecting the   icon displays channel information.  
  
  

 

Wi-Fi Channel Frequencies – 2.4 GHz Channels 

There are 14 Wi-Fi channels in the 2.4 GHz timeline. There are 11 channels available in the USA, 13 
in Europe, and 14 in Japan.  
  
The 14 Wi-Fi channels appear with an orange background along the left side of the timeline. 

 Selecting the icon displays channel information 



 

07-Dec-09 38  300-DOC-BT-000-040  

 

 
   
   
Each Wi-Fi channel is 22 MHz wide and overlap.  There is a 5 MHz shift between each of the first 13 
channels.  There is a 12 MHz shift between channels 13 and 14. 
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Wi-Fi Channel Frequencies - 5 GHz Channels 

There are 165 Wi-Fi channels in the 5 GHz timeline. You access the 5 GHz Timeline by selecting the 
5 GHz radio button. 

 

Only channels with a base value of 5 GHz and spacings of either 20 or 40 MHz are shown here. Due 
to space limitations, each channel is drawn with a fixed height instead of being sized and spaced 
relative to its width and distance from other channels (unlike the 2.4 GHz channels - both Wi-Fi and 
Bluetooth®  - which are sized and spaced relative to each other with the exception of Wi-Fi channel 
14). 
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Bluetooth Timeline 

In addition to the Coexistence View, which displays both Bluetooth® and Wi-Fi data together, you 
can also see more information about Bluetooth in a separate dialog.   The Bluetooth Timeline 
displays packet information with an emphasis on temporal information and payload throughput. 
The timelines also provide selected information from the Frame Display and the Protocol Navigator. 
  

The timelines provide a rich set of diverse information about Bluetooth packets, both individually 
and as a range. Information is conveyed using text, color, graphic size, line type, and position.   

  

Bluetooth Packet Timeline 

You access the Bluetooth Packet Timeline by selecting Bluetooth Timeline from the View menu or 

by pressing the Bluetooth Timeline icon  on the Control Window toolbar, Frame Display, or 
Protocol Navigator. 

 

 

 

Visual Elements 
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The Bluetooth Timeline consists of the following visual elements: 

  

 The timeline shows Bluetooth packets within a specific period of time.   

 The timeline shows Bluetooth packets within a specific period of time.   

 The time segments flow left to right and down, following a complete row across. 
 Then you move down to the next row, go across, then down to the next row, just 
like reading a book, upper left corner to lower right corner. 

 Within each row are two divisions: M (master) and S (Slave). Packets are placed 
on M or S depending on which type of data it is. 

 Placing the mouse pointer on a packet displays information about that packet in 
an information box.  

 Selecting a packet by clicking on it shows information about that packet above 
the timeline.  

 You can use the arrow keys to move to the next or previous packet.You can 
select multiple packets by dragging within the timeline or by holding the SHIFT 
key down while arrowing. 

 Using the mouse scroll wheel scrolls the timeline vertically.  You can also zoom 
by using a right click (which displays specific magnification values), using the + 
and - Zoom tools, or by selecting a value from the Zoom menu. 

 Packet height indicates speed (1, 2, or 3 Mbits/sec). Packet length indicates 
duration (for reference, the duration of a slot is 625-µs). Packet height and 
length together indicate size (speed times duration). 

  

 Rows of Bluetooth Slots  

Each slot begins at the left edge of the vertical blue bar. There are two Bluetooth clocks 
per slot. Each slot represents 0.000625 seconds, or 625 µs. 

 ‘M’ and ‘S’ labels 

Within each row, master and slave packets are indicated on the left side of the row.  By 
default, all possible slave devices (there can be up to 7) are put on the ‘S’ sub-row, but 
checking the “Show slave LT_ADDR” checkbox shows all existing slave device sub-rows 
with numbered labels (some or all of S1, S2, …, S7). 

 Bluetooth Clock 

The Bluetooth clock of the first slot in each row is shown underneath each row. 

 Packet Info Line 

The packet info line appears just above the timeline and displays information for the 
currently selected packet(s).  If only one packet is selected, this information consists of 
the packet number, packet type, Bluetooth  clock (Bluetooth only), and Timestamp.  If 
multiple packets are selected, this information consists of the packet range, the Bluetooth 
clock delta (Bluetooth only), and the Timestamp delta. Selected packets are bounded by a 
magenta rectangle.  See the Packet Navigation and Selection section. 

 Floating Information Window (aka Tooltip) 

file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Packet_Navigation_and_Selection.htm
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The information window displays when the mouse cursor hovers on a packet (not slot). 
 It persists as long as the mouse cursor stays on the packet or tooltip. For Bluetooth, the 
tooltip shows the packet number (in bold), the Baseband layer decode from the decode 
pane of the Frame Display (with the percentage of the Payload Length max added), and 
the decode of the highest layer (if it’s not the Baseband layer) as displayed in the Protocol 
Navigator.   

 Discontinuities 

Discontinuities are indicated by cross-hatched slots.  See the Discontinuities section. 

 Zoom Tools 

Zoom tools zoom in or out while maintaining the position on the screen of the area under 
the zoom tool.  This makes it possible to zoom in or out for a specific packet or area of the 
timeline.  See the “Zooming” section. 

 Packet Status 

Packet status is indicated by color codes. A yellow slot indicates a re-transmitted packet, 
a dark red slot indicates a CRC error, and a small red triangle in the upper-left corner of 
the packet (not the slot) indicates a decode error.   

 Right-Click Menu 

The right-click menu provides zooming and tool selection.  See the “Zooming” section. 

 Graphical Packet Depiction 
Each packet within the visible range is graphically depicted.  See the “Packet Depiction” 
section. 
  

 Swap Button 
The Swap button switches the position of the Timeline and the Throughput graph. 
  

 Show Running Average 
Selecting this check box shows a running average in the Throughput Over Time graph as 
an orange line 
  

 Show slave LT_ADDR 

 Selecting this checkbox displays the Slave LT_ADDR in the timeline row labels. 

 

 

 

 

 

 

 

file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Additional_Displays/Packet%20Timeline/Discontinuities.htm
file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Zooming.htm
file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Zooming.htm
file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Packet_Depiction.htm
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Packet Depiction  

 The timeline shows Bluetooth packets within a specific period of time.   

  
 The timeline shows Bluetooth packets within a specific period of time.   

 The time segments flow left to right and down, following a complete row across.  Then you 
move down to the next row, go across, then down to the next row, just like reading a book, 
upper left corner to lower right corner. 

 Within each row are two divisions: M (master) and S (Slave). Packets are placed on M or S 
depending on which type of data it is. 

 Placing the mouse pointer on a packet displays information about that packet in an 
information box.  

 Selecting a packet by clicking on it shows information about that packet above the timeline.  

 You can use the arrow keys to move to the next or previous packet.You can select multiple 
packets by dragging within the timeline or by holding the SHIFT key down while arrowing. 

 Using the mouse scroll wheel scrolls the timeline vertically.  You can also zoom by using a 
right click (which displays specific magnification values), using the + and - Zoom tools, or by 
selecting a value from the Zoom menu. 

 Packet height indicates speed (1, 2, or 3 Mbits/sec). Packet length indicates duration (for 
reference, the duration of a slot is 625-µs). Packet height and length together indicate size 
(speed times duration). 

  

A packet is drawn using the following components: 

 A “max packet on wire reference” rectangle (light solid lines). This indicates the 
packet on the wire with a max payload. 
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 A “max actual payload reference” rectangle (dark solid lines). This indicates a max 
payload as would be extracted by the receiving device (if the payload on the wire 
contains forward error correction (FEC), it is longer than the actual payload). The 
position of the beginning of the rectangle indicates where the payload begins in time. 

 

 • An “actual payload” colored sub-rectangle (packet category-specific; blue here). This 
indicates the actual received payload with FEC (if any) removed. It is the beginning 
portion of the “max actual payload reference” rectangle. If the actual payload is of max 
size, the entire “max actual payload reference” rectangle is colored. 

 

 • An “unused payload reference” sub-rectangle (always white). This indicates the 
unused portion of a maximum payload. It is the remaining portion of the “max actual 
payload reference” rectangle. The packet on the wire does not leave room for this. It is 
indicated for reference only. 
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 • A “max speed reference” rectangle (dashed lines). This is used to extend the height to 
that of a 3 Mbits/sec packet, and appears only for packets whose speed is less than that. 
The packet shown here has a speed of 1 Mbit/sec because the height of the other 
rectangles is 1/3 of the total height. 

 

The part of the “max packet on wire reference” rectangle (light solid lines) that trails the “max 
actual payload reference” rectangle (dark solid lines) is partly packet on the wire (if the payload on 
the wire contained FEC) and partly trailer (CRC, etc). There is always a trailer, so there is always a 
little space (subject to round off error and pixel granularity) between the ends of the two 
rectangles. 

 

This table shows how packets are colored: 

 

*LMP is a protocol layer that uses either DM1 or DV packets. If a packet has an LMP layer, the LMP 
color is used instead of the packet type color. 
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This table summarizes the various ways in which packet information is presented: 

 

Packet Navigation and Selection 

  

 Buttons, menu items, and keystrokes can be used to go to the next or previous packet, next 
or previous error packet, next or previous retransmitted packet (Bluetooth only), and the 
first or last packet. 

 A single packet is selected either by clicking on it, navigating to it, or selecting it in the 
Frame Display. 

 Selecting Previous Packet with a packet that is currently not visible, places it in the top row 
(i.e. the display scrolls up just enough to make it visible).  

 Selecting Next Packet with a packet that is currently not visible, places it in the bottom row 
(i.e. the display scrolls down just enough to make it visible). 

 Selecting Previous/Next for a packet that’s currently visible selects it without scrolling.  

 Multiple packets are selected either by dragging the mouse or by holding down the shift key 
while navigating or clicking. 

 When a single packet is selected in the timeline, it is also becomes selected in the Frame 
Display.  When multiple packets are selected in the timeline, only one of them is selected in 
the Frame Display. 

 The left arrow key goes to the previous packet.  The right arrow key goes to the next packet. 
 The Ctrl-left arrow key goes to the previous error packet.  The Ctrl-right arrow key goes to 
the next error packet. 
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Zooming 

Zoom features can be accessed from the Zoom menu, clicking a zoom tool on the toolbar, or by right 
clicking on the Timeline window. 

  

A couple of things to remember about Zooming. 

 Zoom tools accessed using the right click menu allow you to maintain the current position 
on the screen and precisely zoom in to a specific packet. 

 Selecting a Zoom icon (+ or -) on the toolbar does not change the pointer to a Zoom Tool. 
 Each distinct click only zooms in our out. 

 Zoom tools accessed from the Zoom Menu have a pointer in the upper-left corner which is 
useful for specifying the zoom location and bringing up a tool tip of a specific packet. 

  

 

Throughput Displays 

  

Throughput is payload over time. There are 3 categories of throughput: 

 Average 

 1-second 

 Graph 
  

In computing throughput, payload is not counted from Bluetooth packets that have a CRC error 
(dark red slot) or that are a retransmission (yellow slot). 

Average Throughput Indicators 

The following figure depicts the Throughput display with the Average Throughput indicators in the 
left column. 
  

 
  

file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Additional_Displays/Packet%20Timeline/Packet_Timeline_Menu_Bar.htm
file:///C:/Documents%20and%20Settings/tab/Desktop/Help%20File%20Backup%20060608/FTS%20Help%20System%20Backup%2002-16-09/FTS%20Help%20System/Additional_Displays/Packet%20Timeline/Packet_Timeline_Button_Bar.htm
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Average throughput is the total payload over the entire session divided by the total time.  Total time 
is calculated by taking the difference in timestamps between the first and last packet. In Bluetooth, 
timestamp difference is used instead of Bluetooth clock count because timestamp difference is 
immune to role switches. However, this can result in inaccuracies when the duration is small 
enough that a coarse timestamp granularity is significant. 
  

 Average throughput is shown as 0 when there is only one packet, because in that case the 
timestamp difference is 0 and an average cannot be computed. 

 Average throughput is shown for all devices, master devices, and slave devices.    

 A horizontal bar indicates percentage of max, and text gives the actual throughput. 

One Second Throughput Indicators 
  

 1-second throughput is the total payload over the most recent one second of duration (This 
is determined by counting Bluetooth clocks). It is cleared after each discontinuity.  A 
 discontinuity is when the Bluetooth clock goes forward more than 2 seconds or goes 
backwards any amount.  This is caused by either a role switch or Bluetooth clock rollover . 
 The Bluetooth  clock count is used instead of timestamp difference because the Bluetooth 
 clock count is precise; however, if timestamp difference were used it would not be 
necessary to clear the 1-second throughput after each discontinuity. 

 1-second throughput is not an average.  It is simply the total payload over the most recent 
one second of duration.  Since it’s not an average, it behaves differently than average 
throughput.  In particular, while average throughput can be very large with only a couple of 
packets (since it’s dividing small payload by small time), 1-second throughput is very small 
(since it counts only what it sees and doesn't try to extrapolate). 

 A 1-second throughput is shown for all devices, master devices, and slave devices.    

 A horizontal bar indicates percentage of max, and text gives the actual throughput. 

Throughput Graph 

  

The following figure depicts the Throughput Graph (Throughput Over Time). 

 
  
The throughput graph shows total payload for each successive time interval. The time interval is 
initially 0.1 second. Each time the number of throughput elements reaches 100, they are collapsed 
into a set of 50 by combining adjacent elements and doubling the duration of each element. 
Collapsing thus occurs as follows: 
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The bottom of the graph shows a beginning time and an ending time.  The beginning time is relative 
to the start of the session and initially 0.  When packets start wrapping out it becomes the relative 
time offset of the first available packet.  The ending time is always the total time of the session. 

Discontinuities are indicated by vertical dashed lines. 

A green view port indicates the time range corresponding to the visible slots in the timeline.  The 
view port can be moved by clicking elsewhere in the graph or by dragging.  Whenever it is moved, 
the timeline scrolls to match.  When the slot range in the timeline changes, the view port moves and 
resizes as necessary to match. 

  

 The Swap Button 
The Swap button switches the position of the Timeline and the Throughput graph. 
  

 Show Running Average 
Selecting this check box shows a running average in the Throughput Over Time graph as 
an orange line 

Discontinuities 

The following figure depicts a Discontinuity between two packets. 

 

  

To keep the timeline and the throughput graph manageable, big jumps in the Bluetooth clock are 
not represented linearly. Instead, they are shown as discontinuities.   A discontinuity is said to exist 
when the Bluetooth clock goes forward more than 2 seconds or backwards any amount. A 
discontinuity is indicated by a cross-hatched slot in the timeline and a corresponding vertical 
dashed line in the throughput graph. The Bluetooth clock can jump forward when capture is paused 
or when there is a role switch (in a role switch, a different device becomes master, and since each 
device keeps its own Bluetooth clock, the clock can change radically), and backwards when there is 
a role switch or clock rollover. 
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Timeline Button Bar 

  

The button bar contains the following: 

 
  

 

Lock - The Lock button only appears in live mode and is automatically depressed when 
the user scrolls. 

   
Unlock 

 

First Packet 

 

Previous Packet 

 

Next Packet 

 

Last Packet 

 

Previous Retransmitted Packet 

 

Next Retransmitted Packet 

 

Previous Error Packet 

 

Next Error Packet 

 

Zoom In - Click on the icon each time to zoom in from 4800 slots to 12 slots 

 

Zoom Out  - Click on the icon each time to zoom out from 12 slots to 4800 slots 

 

Reset - The Reset button appears only in live mode.  Reset causes all packet data up to 
that point to be deleted from the Packet Timeline display.  This does not affect the data in 
the Frame Display or Protocol Navigator.  Resetting the display may be useful when the 
most recent throughput values are of interest. 

Legend 

  

This legend identifies the color coding found in the timeline.  
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Exiting FTS4BT 

To exit FTS4BT: 

Go to the File menu on the Control window, and choose Exit FTS4BT, or close the Control window 
using the X icon in the top right corner of the title bar. 

If you are in Air Sniffing mode, you will also need to close the Datasource by choosing Terminate 
from the File Menu on the Datasource or using the X icon in the top right corner.  
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Technical Support 

Technical support is available in several ways. The online help system provides answers to many 
user related questions. Frontline’s website has documentation on common problems, as well as 
software upgrades and utilities to use with our products. 

Web: http://www.fte.com, click Support 

Email: tech_support@fte.com 

If you need to talk to a technical support representative, support is available between 9am and 
5pm, U.S. Eastern time, Monday through Friday. Technical support is not available on U.S. national 
holidays. 

Phone: +1 (434) 984-4500 

Fax: +1 (434) 984-4505 
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Appendix A 

Bluetooth ComProbe Maintenance 

The Bluetooth ComProbe Maintenance Utility is used to configure Bluetooth ComProbes and to 
upgrade the Firmware.  Bluetooth ComProbes® should be upgraded to the newest firmware release 
to take advantage of new features and fixes.  

Upgrading Your Bluetooth ComProbe 

1. Start the Bluetooth ComProbe Maintenance Utility. Open the FTS4BT desktop folder, then the 
Setup folder and double click the shortcut to the utility, or from your Windows operating system 
click Start | Programs | FTS4BT [version#] | Setup |  ComProbeMaintenance. A screen similar to 
the following appears: 

 

Figure 32 - Bluetooth ComProbe Maintenance Utility 

2. Connect the ComProbe to the PC and click on the [Select Device] button. To avoid mistakes, it is 
recommended that only one ComProbe be connected at a time.    

 

Figure 33 - Bluetooth ComProbe Maintenance Utility\Select Device 
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Select [Yes].  Older ComProbes® will display an error indicating the ComProbeis older and needs 
replacing.  Note that when you do this, the [Device Information], [Check Configuration] and [Update 
Firmware] buttons should become available.  [Update Firmware] will not be accessible if you are 
using an older ComProbe®.  

 

3. Select the [Update Firmware] button. The utility will display a dialog titled “Select the firmware 
file to download”. 

4. There may be more than one firmware file with extension “.dfu” in the directory.  The version 
number of the firmware will be in the name of the file.  Please select the version you want 
(typically you should choose the highest version number) and then press the [Open] button. 

If everything works correctly, the Utility should then display: 

 

Figure 34 - Bluetooth ComProbe Maintenance Utility\Successful Update 

Press the [OK] button. 

Please note that during the firmware update process, the ComProbe is switched from normal 
operating mode into “device firmware upgrade” (DFU) mode.   If this is the first time that a 
Bluetooth ComProbe firmware upgrade has been performed on this computer, the “Found New 
Hardware Wizard” may appear asking you for location of the device driver. Those may be found in 
the “Bluetooth ComProbe” sub-folder under the “Drivers” folder.  For further information on using 
the “Found New Hardware Wizard” to install the Bluetooth ComProbe consult the Quick Start Guide 
under “Bluetooth ComProbe Installation”. 

5. As a final check of readiness, press the [Device Information] button.  

 The “Device Name” should be “Frontline Test Equipment Bluetooth ComProbe”; 

 The “Device Address” should match the address printed on the label attached to the back of 
the device; 

 “Firmware ID” should identify the latest shipping firmware. 

6. Press the [OK] button. 

7. Exit the Maintenance Utility by pressing the [Exit] button. 

 


